
 

Manual del usuario 

 

Bobina de mama SPEEDER CX 

para sistemas de RM 1.5T de Canon 

 

 
 

 

N.º de modelo Canon QED   

MJAM-147A Q7000125 



 
 
 

2 | Página  6000919 Rev. 3 
 

Garantía y responsabilidad 

Tras la entrega del producto, la responsabilidad del mantenimiento y del uso de este recae sobre el cliente 

que compró el producto. La garantía no cubre los casos que se indican a continuación, ni siquiera durante el 

periodo de garantía: 

• Daño o pérdida derivados del abuso o uso indebido del producto. 

• Daño o pérdida provocados por casos de fuerza mayor como incendios, terremotos, inundaciones, 

rayos, etc. 

• Daño o pérdida provocados por el incumplimiento de las condiciones especificadas para el equipo, 

por ejemplo, suministro de energía inadecuado, instalación incorrecta o condiciones inaceptables 

del entorno. 

• Daño derivado de los cambios o modificaciones realizados al producto.  

En ningún caso será QED responsable de lo siguiente: 

• Daño, pérdida o problemas provocados por la reubicación, modificación o reparación realizada por 

personal no autorizado expresamente por QED.  

• Daño o pérdida originados por negligencia o por ignorar las precauciones e instrucciones de 

funcionamiento recogidas en este manual del usuario. 

Condiciones de transporte y almacenamiento 

Este equipo se deberá transportar y almacenar de conformidad con las condiciones siguientes: 

 
Temperatura  De -10 °C a +50 °C 

 
Humedad relativa  Del 20 % al 95 % 

 
Presión atmosférica  De 700 hPa a 1060 hPa 

 

Los indicadores de choque para monitorizar el transporte están adheridos al embalaje. Si el indicador de choque 

se ha activado tal y como se muestra, con un color rojo dentro del tubo de vidrio, la bobina no se manipuló con el 

cuidado necesario. No obstante, un indicador de choque activado no indica necesariamente daños en la bobina.  

 
PRECAUCIÓN 

Si el embalaje de la bobina queda expuesto a condiciones ambientales que no cumplen las 
condiciones de transporte y almacenamiento, si el embalaje presenta daños, si el embalaje se 
abre antes de la entrega o si el indicador de choque se ha activado, realice la prueba de control 
de calidad antes de usar el producto. Si la bobina supera las pruebas de control de calidad, 
se puede usar con normalidad. 

 

Legislación Federal de los Estados Unidos 

Precaución: La legislación federal limita la venta, distribución y uso de este dispositivo a médicos colegiados, 

o bajo la correspondiente prescripción médica. La legislación federal limita el uso de este dispositivo a fines de 

investigación cuando la indicación para la que se usa no está incluida en la declaración de indicaciones. 
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Acerca de este manual 
Este manual incluye información detallada sobre las precauciones de seguridad, el uso y el 

cuidado de la bobina de RF.  

 

Para garantizar la seguridad y la precisión al usar este producto, lea con atención 

y comprenda el contenido de este manual, así como del manual del usuario y del 

manual de seguridad del sistema de RM antes de utilizar el producto. Este manual 

no incluye las instrucciones ni la información de seguridad de los equipos no 

suministrados por QED, como el sistema de RM. Consulte al fabricante del sistema de 

RM en cuestión para obtener información sobre los equipos que no son de QED. 

 

El manual del usuario en formato PDF está a su disposición en 

Internet, en la dirección www.qualityelectrodynamics.com. 

Para solicitar una copia impresa del manual del usuario, 

envíe un correo electrónico a info@qualedyn.com o rellene el 

formulario de contacto en www.qualityelectrodynamics.com. 

Leyenda  

En este manual se utilizan los siguientes símbolos para destacar instrucciones de seguridad y otras 

indicaciones importantes. El nombre de los iconos y su significado se explica a continuación.  

 
PRECAUCIÓN 

PRECAUCIÓN 

Es necesario tener precaución para evitar una situación peligrosa que, de no 
evitarse, podría provocar lesiones leves o moderadas. 

 

 

INFORMACIÓN 

Destaca detalles importantes o brinda información para evitar errores de 
uso u otras situaciones potencialmente peligrosas que, de no evitarse, 
podrían provocar daños al producto. 

 

  

i 

http://www.qualityelectrodynamics.com/
mailto:info@qualedyn.com
http://www.qualityelectrodynamics.com/
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Capítulo 1 – Introducción 
1.1 Descripción 

Las bobinas de RF de solo recepción reciben las señales de resonancia magnética generadas 

en los núcleos de hidrógeno (protones) del cuerpo humano. Las señales recibidas se amplifican 

y transmiten al sistema de RM, donde dichas señales se procesan y convierten en imágenes 

tomográficas. 

La bobina de mama SPEEDER CX se utiliza para examinar la mama. 

1.2 Entorno operativo y compatibilidad 

La bobina de mama SPEEDER CX está diseñada para su uso junto con los siguientes sistemas de 

RM 1.5T de Canon en un centro de atención médica especializado: 

• Vantage Titan 1.5T 

• Vantage Orian 1.5T 

• Vantage Elan 1.5T 

• Vantage Fortian 1.5T 

1.3 Perfiles de usuario 

Operador: técnicos en radiología, técnicos de laboratorio y médicos.  

Formación del usuario: para usar esta bobina no es necesaria ninguna formación especial. 

No obstante, Canon Medical Systems ofrece un curso de formación integral para los sistemas 

de RM con el fin de instruir a los operadores en el uso correcto de los sistemas de RM. 

1.4 Información de la paciente 

Edad, salud y estado: sin ninguna limitación especial. 

Peso: 255 kg o menos (consulte el manual de instrucciones del sistema de RM y, si el peso 

máximo permitido de la paciente para ese sistema es inferior al peso permitido para esta 

bobina, hay que darle prioridad al peso máximo del sistema). 
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Capítulo 2 – Componentes de la bobina de mama 

SPEEDER CX 
2.1 Componentes incluidos  

La bobina de mama SPEEDER CX se entrega con los componentes que se muestran a 

continuación. Cuando reciba la unidad, asegúrese de que todos los componentes están 

incluidos. Póngase en contacto con su representante de Canon Medical Systems para 

reemplazar o solicitar repuestos de cualquiera de los accesorios enumerados aquí. 

Imagen Descripción Cantidad 
N.º Ref. 

Canon 

N.º Ref. 

QED 

 

Bobina de 

mama SPEEDER 

CX 

1 MJAM-147A Q7000125 

 

Almohadilla 

protectora 
1 BSM41-6404 3003080 

 

Almohadilla 

para el esternón 
1 BSM41-6405 3003081 

 

Almohadilla 

medial 
2 BSM41-6406 3003084 

 

Almohadilla de 

transición 
1 BSM41-6407 3003082 
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Imagen Descripción Cantidad 
N.º Ref. 

Canon 

N.º Ref. 

QED 

 

Almohadilla 

para 

reposacabezas 

1 BSM41-6408 3003079 

 

Reposacabezas 1 BSM41-6409 2000588 

 

Placa de 

compresión 
2 BSM41-6410 3003225 

 

2.2 Accesorios opcionales (se venden por separado) 

Elevador de mama: Breast Riser 
CX, MJCA-247A 

Este accesorio se utiliza para ajustar la altura de 
la bobina. 

Esta opción es para sistemas de RM de túnel grande 
(Vantage Titan, Vantage Orian, etc.). 

Soporte de rejilla: Grid Holder 
CX, MJCA-257A 

Este accesorio se utiliza para sujetar una rejilla de 
biopsia. La rejilla en sí la proporciona un proveedor 
de rejillas. 

 

 
PRECAUCIÓN 

Siga las instrucciones de los manuales de instrucciones del soporte de rejilla CX y las 
rejillas de biopsia, si se utilizan.  
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Capítulo 3 – Seguridad 
Esta sección explica las precauciones generales y la información de seguridad que deben tenerse 

en cuenta durante la utilización de esta bobina.  

 
PRECAUCIÓN 

Antes de usar la bobina, revise la información de seguridad en el manual de 
instrucciones del sistema de RM para obtener una lista completa de las 
consideraciones de seguridad. 

 

3.1  Glosario de símbolos 

Símbolo Número Norma Título, significado 

 
1641 

ISO 7000 
IEC 60417 

Manual del usuario, consulte las instrucciones 
de funcionamiento antes de usar el dispositivo 

 
5172 

ISO 7000 
IEC 60417 

Equipo de clase II 

 
5333 

ISO 7000 
IEC 60417 

Pieza aplicada de tipo BF 

 
3082 

ISO 7000 
IEC 60417 

Fabricante y fecha de fabricación 

 
6192 

ISO 7000 
IEC 60417 

Bobina de RF, recepción 

    
N/D 

IEC 60601-2-33 
IEC 62570 

MR seguro 

 
5.1.2 ISO 15223-1 Indica el representante autorizado en la UE 

 
5.1.2 

ISO 15223-1 
ISO 20417 

Indica la persona responsable en el 
Reino Unido 

 
5.1.2 

ISO 15223-1 
SwissMedic 

Indica el representante autorizado en Suiza 

 
2493 

ISO 7000 
IEC 60417 

Número de referencia 

 
2498 

ISO 7000 
IEC 60417 

Número de serie 

 
0632 

ISO 7000 
IEC 60417 

Límite de temperatura 

 
2620 

ISO 7000 
IEC 60417 

Límite de humedad 

 
2621 

ISO 7000 
IEC 60417 

Límite de presión atmosférica 
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Símbolo Número Norma Título, significado 

 5.7.7 ISO 15223-1 Producto sanitario 

 

N/D EN50419 
EU2012/18/EU 

El uso de este símbolo indica que este producto 
no debe tratarse como residuo doméstico. 
Asegúrese de desechar este producto 
correctamente. Esto contribuye a evitar 
consecuencias potencialmente negativas para 
el medio ambiente y para la salud de las 
personas, lo cual podría suceder si este 
producto se desecha de manera inadecuada. 
Para obtener información más detallada 
acerca de la devolución y el reciclaje de este 
producto, consulte con el proveedor al que 
compró el producto. 

 
5.1.8 ISO 15223-1 Importador 

 
5.1.9 ISO 15223-1 Distribuidor 

 

3.2 Indicaciones 

La bobina de mama SPEEDER CX está diseñada para su uso con los sistemas de RM 1.5T de 

Canon y producir imágenes de diagnóstico de la anatomía del seno que puedan ser 

interpretadas por un médico cualificado. 

3.3 Contraindicaciones 

Ninguna. 

3.4 Advertencias 

 Las pacientes con mayor probabilidad de sufrir ataques o claustrofobia podrían requerir 

una atención especial. Consulte el manual de instrucciones del sistema de RM. 

 Las pacientes que están inconscientes, muy sedadas o en un estado mental confuso 

tienen un mayor riesgo de sufrir quemaduras porque es posible que no puedan avisar al 

operador de que tienen calor o sufren dolor debido a un calor excesivo y al daño tisular. 

 Las pacientes que no puedan mantener una comunicación fiable (por ejemplo, por su 

corta edad) corren un mayor riesgo de sufrir quemaduras porque es posible que no 
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puedan avisar al operador de que tienen calor o sufren dolor debido a un calor excesivo 

y al daño tisular. 

 Las pacientes con pérdida de sensibilidad en cualquier parte del cuerpo corren un mayor 

riesgo de sufrir quemaduras porque es posible que no puedan avisar al operador de que 

tienen calor o sufren dolor debido a un calor excesivo y al daño tisular. 

 Las pacientes que tienen dificultad para regular su temperatura corporal o que son 

especialmente sensibles a una subida de la temperatura corporal (por ejemplo, 

pacientes con fiebre, insuficiencia cardiaca o problemas de transpiración) corren un 

mayor riesgo de sufrir quemaduras o una subida de la temperatura corporal. 

 Asegúrese de que la ropa de la paciente no esté mojada o humedecida por la 

transpiración. La presencia de humedad aumenta el riesgo de sufrir quemaduras. 

3.5 Precauciones: Bobina de RF 

 No coloque ningún dispositivo desconectado (bobinas de RF, cables, etc.) en el gantry 

durante la exploración. Retire las bobinas de RF innecesarias de la superficie de la 

camilla y confirme que las bobinas de RF en uso están conectadas al puerto de conexión 

antes de la exploración.  

Las bobinas de RF desconectadas presentes durante la exploración pueden provocar la 

formación de un bucle de corriente de inducción de alta frecuencia, lo que provocaría 

quemaduras en la paciente. Además, los dispositivos podrían sufrir daños. 

 Conecte únicamente las bobinas de RF designadas en el puerto de conexión de la bobina 

de RF. 

 No use una bobina de RF defectuosa, especialmente si la cubierta exterior está dañada 

o si hay piezas metálicas al descubierto. Existe riesgo de descarga eléctrica. 

 No intente cambiar ni modificar la bobina. 

Las modificaciones no autorizadas pueden 

provocar quemaduras, descargas eléctricas 

o una menor calidad de la imagen. 

 No cruce ni enrolle los cables de la bobina. 

Se podría formar una corriente de alta frecuencia y dar lugar a quemaduras.  

 Asegúrese de que la paciente no esté en contacto directo con los cables de la bobina. 

Pueden producirse quemaduras debido al campo eléctrico que se genera en la bobina 

de RF cuando se transmite un campo magnético de alta frecuencia. 

 No permita que la paciente se coloque de tal forma que cree un bucle con alguna parte 

de su propio cuerpo. Use las bases de apoyo para asegurar que las manos y las piernas 
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de la paciente no toquen la bobina, el sistema de RM, la camilla ni ninguna otra parte 

del cuerpo con la que puedan crear un bucle. Se podría formar una corriente de alta 

frecuencia y dar lugar a quemaduras. 

 

 No permita que la paciente ni la bobina de RF entren en contacto con la pared interna del 

gantry. Separe a la paciente de la pared interna del gantry un mínimo de 10 mm con 

almohadillas de espuma. Separe a la paciente del cable de la bobina de RF con almohadillas 

de espuma. Pueden producirse quemaduras debido al campo eléctrico que se genera en la 

bobina de RF, etc. cuando se transmite un campo magnético de alta frecuencia. 

 Confirme que el cable de la bobina esté sobre la superficie de la camilla antes de 

introducir a la paciente en el gantry. Si la superficie de la camilla se mueve con el cable 

sobresaliendo, el cable puede interferir con la unidad principal del sistema de RM, lo 

que podría provocar el cambio de posición de la bobina o que el sistema atrape a la 

paciente y le produzca lesiones. 

 Detenga la exploración inmediatamente si la paciente se queja de calor, hormigueo, 

picor o alguna otra sensación similar. Póngase en contacto con un médico antes de 

continuar con la exploración.  

 Asegúrese de que la bobina no entra en contacto con ningún líquido, como agua o 

medicamentos.  

 El recinto de la bobina y los componentes internos de la bobina podrían aparecer en las 

imágenes en determinadas circunstancias de adquisición de imágenes (por ejemplo, cuando 

se usa una secuencia con un tiempo de eco corto (TE) o cuando los píxeles son grandes). 

 Si advierte que una bobina está defectuosa, deje de usarla de inmediato y póngase en 

contacto con su representante de Canon.  
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 Con la bobina solo se deben usar los accesorios indicados en este manual. 

3.6 Precauciones: Bobina de mama SPEEDER CX 

 No permita que la superficie de la cinta gancho de las fijaciones de velcro entre en 

contacto con la paciente. La bobina y las almohadillas incorporan fijaciones de velcro 

para facilitar la inmovilización mediante correas. Si la piel de la paciente roza con la 

superficie de la cinta gancho de estas fijaciones, podría sufrir lesiones. Tenga cuidado al 

manipular componentes con fijaciones de velcro. 

Posiciones de las fijaciones de velcro 

 

Unidad principal de la bobina (en el lateral y en la parte superior) 

  

Almohadilla protectora  
(en la parte inferior) 

Almohadilla para el esternón  
(en la parte inferior) 

3.7 Procedimientos de emergencia 

Si se produjera una emergencia durante la exploración, detenga la exploración de inmediato, 

saque a la paciente de la sala y busque asistencia médica, si fuera necesario. 

En caso de un incidente grave en la UE, el incidente se debe notificar al fabricante y a la 

autoridad competente del estado miembro en el que esté establecido el centro al que ha 

acudido el usuario.  
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Capítulo 4 – Control de calidad  
4.1 Prueba de imagen con la herramienta de medición automática 

de SNR 

Si el manual de instrucciones del sistema incluye descripciones sobre la herramienta de 
medición automática de SNR, la prueba de imagen se puede realizar con la herramienta 
de medición automática de SNR. 

Bobina Fantoma N.º Ref. 

Bobina para columna vertebral 
Octave SPEEDER Spine 

Fantoma de sulfato de 
cobre de 5 L 

BSM41-1623 

 

Cuando vaya a utilizar la herramienta de medición automática de SNR, prepare las herramientas 
necesarias consultando el manual de instrucciones del sistema. 

Con el software del sistema V6.0 o de versión posterior, se utilizan unas secuencias de 
exploración diferentes. Tenga esto en cuenta. Sin embargo, no hay diferencias en la 
configuración de la bobina ni en la selección de la sección de la bobina. 

4.2 Selección de secuencias para la versión V6.0 o posteriores 

(prueba de imagen sin usar la herramienta de medición 

automática de SNR) 

(1) Registre a una paciente y defina su peso en 60 kg. 

(2) Seleccione [Typical PAS] (PAS típica) → [Coil QA] (Control de calidad de la bobina) y haga 
clic en el botón [Other] (Otro). Seleccione las secuencias requeridas de la PAS «Otro». 

Los nombres de secuencia para las versiones V4.5 o anteriores y los nombres de secuencia 
correspondientes para las versiones V6.0 o posteriores se muestran a continuación. 

V6.0 o posterior V4.5 o anterior Requerido/No requerido 

Localizador FE_slt Requerido 

Mapa No utilizado No requerido 

SNR SE15 Requerido 

* Para las versiones V6.0 o posteriores, no es necesario seleccionar las condiciones de 
reconstrucción. 

(3) Realice la medición de SNR como se describe en la sección 4.2 aplicando las secuencias 
seleccionadas en el paso (2). Los parámetros deben cambiarse de acuerdo con los 
procedimientos de medición de SNR. 
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4.3 Medición de SNR 

(1) Lea la temperatura en la sala apantallada y confirme que la temperatura esté entre 
16 °C y 24 °C. 

(2) Coloque la bobina sobre la superficie de la camilla en la orientación que se muestra 
a continuación y conéctela al puerto A1 de la superficie de la camilla. 

Colocación de la bobina 
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(3) Desbloquee las cuatro pestañas de bloqueo moviéndolas hacia abajo como se muestra 
a continuación. 

Pestañas de bloqueo 

  

Desbloquee las pestañas de bloqueo 
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(4) Mueva las bobinas laterales a las posiciones límite en dirección horizontal.  

Coloque las bobinas laterales 

 

(5) Bloquee las cuatro pestañas de bloqueo moviéndolas hacia arriba. 

Bloquee las pestañas de bloqueo 
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(6) Confirme que las bobinas laterales estén en la posición más baja. Si las bobinas no están en 

la posición más baja, retire las bobinas laterales y colóquelas en la posición más baja.  

Confirme la posición correcta de las bobinas laterales 

 

 

Si es necesario, retire las bobinas laterales y vuelva a colocarlas en la posición más baja
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(7) Coloque las almohadillas de la bobina medial a ambos lados de la bobina medial.  

Coloque las almohadillas mediales  

 

(8) Coloque dos fantomas de CuSO4 de 5 L en la bobina. Alinee el haz del proyector de 

posicionamiento con el centro de la bobina lateral y envíe la bobina de mama SPEEDER CX 

al centro del campo magnético.  

Coloque los fantomas 

 
Marcador central 

para la bobina 
lateral 

Haz del proyector 

(9) Espere aproximadamente 5 minutos para que se estabilice el líquido en el fantoma. 

(10) Seleccione la secuencia FE_slt de la carpeta SEQ. Configure los parámetros de la secuencia 
de la siguiente manera. 

<Condiciones de exploración> 

FE_slt, Plan especial (Axial: 1, Sagital: 1, Coronal: 1), TR: 50, NS: 3, ST: 8 mm,  
FA: 90, FOV: 50 cm, MTX: 256  256 
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(11) Establezca los parámetros de la siguiente manera. 

Bobina de RF : BreastCX bilateral 

Orientación de la paciente : Prono 

Región SAR : Mama 

Dirección de inserción : Cabeza primero 

Dirección de visualización : Pies 

(12) Ejecute la exploración del localizador. 

(13) Seleccione la secuencia SE15 de la carpeta SEQ y configure los parámetros de la secuencia 
de la siguiente manera. A continuación, establezca la posición de corte. (Figura 6.3-11) 

<Condiciones de exploración> 

SE15, CO: HF, TR200, NS: 3, ST: 5 mm, Espacio: 2 mm, FA: 90/180,  
FOV: 45 cm  45 cm, MTX: 256 x 256, NoWrap: PE 1.0/RO 2.0 

<Posicionamiento de corte> 

Coloque los cortes utilizando la imagen del localizador. 

Dirección HF y dirección RL : Establezca la posición central del FOV en el punto 
medio entre los dos fantomas. 

Dirección AP : Establezca la posición del corte central 6 cm por 
debajo de la parte inferior del fantoma. 
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Posición de corte 

 

(14) Haga clic con el botón derecho en la ventana «Sequence Editor» (Editor de secuencias) 
y seleccione «Reconstruction» (Reconstrucción) en el menú emergente. En la ventana 
de selección de filtros que se muestra, seleccione «Refine Filter» (Refinar filtro) y 
«NONE: No filter» (NINGUNO: Sin filtro). 

Seleccione «Reconstruction» (Reconstrucción) 
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Seleccione «Refine Filter» (Refinar filtro) y «NONE: No filter» (NINGUNO: Sin filtro) 

 

(15) Cierre la ventana «Scan Plan» (Plan de exploración) haciendo clic en [Queue & Exit] 
(Poner en cola y salir) y ejecute la secuencia. 

(16) Seleccione la pestaña «PostProc.» (Postprocesamiento) y seleccione «File» (Archivo) 
y «Options» (Opciones) en la ventana «Image Matrix» (Matriz de imagen).  
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Pestaña «PostProc.» (Postprocesamiento) 

  

Ventana «Image Matrix» (Matriz de imagen) 

 

 

(17) En la ventana «Image Matrix Options» (Opciones de matriz de imagen), seleccione «Show» 

(Mostrar) para la opción «Intermediate» (Intermedio). 
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 Ventana «Image Matrix Options» (Opciones de matriz de imagen) 

 

(18) Muestre el corte central de la imagen adquirida del fantoma en la que el último número de 

identificación es 0.  

Imagen del fantoma 

La última 
identificación es 0 

 

Mostrar esta imagen 

La última 
identificación es 1 

 

 

 

(19) Establezca la región de interés (ROI) de la señal y la ROI del ruido en las posiciones que se 

indican a continuación. 
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Posición de la región de interés (ROI) 

ROI del ruido: 2 x 10 cm 
Punto medio de los fantomas (evitando artefactos) 

 
ROI de la señal: ɸ2,5 cm 

(derecha) 
Centro del fantoma 

ROI de la señal: ɸ2,5 cm 
(izquierda) 

Centro del fantoma 

 

(20) Mida el valor de la señal (media) y el valor del ruido de fondo (NoiseSD). 

(21) Calcule la relación SNR aplicando la siguiente ecuación. 

(22) Ecuación de cálculo de SNR 

SNR = S/N  C 

donde: 

S: Valor de la señal medida (media) (para la ROI de la señal) 

N: Valor del ruido de fondo (valor NoiseSD) 

C: Coeficiente de temperatura (consulte la tabla a continuación) 

Temperatura de la sala apantallada (C) Coeficiente de temperatura C 

16 0.840 

17 0.863 

18 0.888 
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19 0.913 

20 0.940 

21 0.969 

22 1.000 

23 1.033 

24 1.068 

<Norma> 

SNR (derecha)  180 

SNR (izquierda)  180 
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Capítulo 5 – Instalación y uso de la bobina  
5.1 Instalación de la bobina 

5.1.1 Instalación y extracción de las bobinas laterales 
Las bobinas laterales deben estar instaladas para adquirir las imágenes. 

(1) Bloquee las bobinas laterales en su sitio moviendo las pestañas de bloqueo hacia arriba 
y confirme que las bobinas no se pueden mover horizontalmente. 

Pestañas de bloqueo 

  

Bloquee las pestañas de bloqueo 

 

(2) Para extraer la bobina lateral, agarre la bobina y empújela hacia el lado del cable. Al mismo 
tiempo, tire del lado opuesto para extraerlo del soporte. 
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Agarre la bobina, empuje ligeramente hacia el lado del cable mientras tira del lado opuesto 
para extraerlo del soporte 

  

 
PRECAUCIÓN 
 

Tenga cuidado de no pillarse los dedos al extraer la bobina lateral. Podría 
sufrir alguna lesión. 
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1. Al retirar la bobina lateral, sujétela con cuidado. No utilice una fuerza excesiva 

y no tire del cable ni lo tuerza. El incumplimiento de estas precauciones puede 

resultar en un fallo de los contactos o en la desconexión del cable. 

  

2. Cuando mueva a la paciente hacia el gantry, confirme que las bobinas laterales 

estén colocadas en el soporte o en la superficie de la camilla. Si las bobinas 

laterales extraídas están en el espacio entre la superficie de la camilla y el gantry, 

la bobina lateral podría quedar atrapada en la superficie de la camilla durante 

el movimiento.  

  

 

(3) Para instalar la bobina lateral, coloque la bobina lateral contra el lado izquierdo del soporte. 
A continuación, empuje el lado opuesto hacia dentro. La bobina debería encajar en el soporte. 
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Instalación de las bobinas laterales 

 

 
PRECAUCIÓN 
 

Extraiga o instale la bobina lateral cuando el soporte de la bobina esté a 1 cm 
o más del seno de la paciente para evitar posibles pellizcos. Podría sufrir 
alguna lesión. 

 

 

5.1.2 Instalación y extracción de las placas de compresión  
Para obtener imágenes con las placas de compresión, se deben instalar tanto las placas de 
compresión como las bobinas laterales.  

(1) Para instalar la placa de compresión, extraiga la bobina lateral como se describe en la 
sección 5.1.1. 

(2) Inserte la placa de compresión como se muestra a continuación. Asegúrese de que las 
«pestañas» de la placa miran hacia fuera. La placa debe instalarse desde el lateral, no desde 
la abertura superior de la bobina. Asegúrese de que las ranuras del lateral de la placa de 
compresión coinciden con las delgadas paredes que sobresalen del soporte. 
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Instalación de la placa de compresión 

  

(4) Instale la bobina lateral como se indica en la sección 5.1.1. 

 
1. La bobina lateral debe estar en su sitio para comprimir el tejido mamario. 

2. La bobina lateral y la placa de compresión deben moverse juntas. 

 

(5) Para retirar la placa de compresión, extraiga la bobina lateral como se describe en la 
sección 5.1.1 y luego retire la placa de compresión. 

5.1.3 Ajuste de las posiciones horizontal y vertical de las bobinas laterales 
Las bobinas laterales se pueden mover en dirección vertical y horizontal para optimizar sus 
posiciones en función del tamaño de los senos. 

Opciones de ajuste de las bobinas laterales 
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(1) Para ajustar la posición horizontal de las bobinas laterales, desbloquee las pestañas de 
bloqueo moviéndolas hacia abajo y luego mueva cada bobina lateral hasta su posición 
horizontal máxima. Bloquee las bobinas en su sitio moviendo las pestañas de bloqueo 
hacia arriba. Confirme que las bobinas no se puedan mover horizontalmente. 

Desbloquee las pestañas de 
bloqueo 

Mueva cada bobina lateral a su posición 
horizontal máxima 

 
 

Bloquee las pestañas de bloqueo 

 

(2) Para ajustar la posición vertical de las bobinas laterales, extraiga la bobina lateral. 

Extraiga la bobina lateral 

 



 
 
 

32 | Página  6000919 Rev. 3 
 

(3) Vuelva a instalar la bobina lateral en la posición vertical requerida. La bobina lateral se 
puede instalar en tres posiciones verticales diferentes. 

Tres posiciones verticales disponibles para la bobina lateral 

 

 
1. Cuando mueva la bobina lateral verticalmente, confirme que la bobina lateral 

esté instalada en la misma posición vertical en los lados izquierdo y derecho 
de la bobina. Si la bobina lateral queda inclinada, es posible que la bobina 
no permanezca en su sitio en el soporte. Si la bobina se mueve durante la 
exploración, podría afectar la calidad de la imagen. 

   

2. Si la bobina lateral se instala en la posición vertical media o más alta, 
el movimiento horizontal estará limitado. 
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5.2 Elección de los elementos de la bobina utilizados para la 

adquisición de imágenes  

La bobina de mama SPEEDER CX contiene las bobinas y los elementos que se muestran en el 
siguiente diagrama. Los elementos que se utilizan durante la adquisición de imágenes se eligen 
según el tipo de bobina mostrado, como se ve en la siguiente tabla. 

Diagrama de bobinas y elementos de SPEEDER CX 

 

Mama izquierda Mama derecha 

Número Descripción 

1 Elemento izquierdo de la bobina en forma de silla de montar 

2, 6 Elementos de la bobina medial 

3, 4 Elementos de la bobina lateral izquierda 

5 Elemento derecho de la bobina en forma de silla de montar 

7, 8 Elementos de la bobina lateral derecha 

9 Bobina medial 

10 Bobinas laterales 
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Elementos utilizados con cada tipo de bobina 

N.º Tipo de bobina Descripción 

1 BreastCX bilateral Adquisición de imágenes bilaterales por todos los elementos 
Elementos utilizados: 1, 2, 3, 4, 5, 6, 7, 8 
Factor de SPEEDER disponible:  
Máx. 2,0 (dirección RL, PE) 
Máx. 1,6 (dirección RL, SE*) 

* Podría no estar disponible en algunos paquetes de software  
de los sistemas Titan y Orian. 

Máx. 1,3 (dirección AP, PE) 

 

2 BreastCX izquierda Adquisición de imágenes unilaterales de la mama izquierda de la paciente 
Elementos utilizados: 1, 2, 3, 4 
SPEEDER no está disponible. 
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N.º Tipo de bobina Descripción 

3 BreastCX derecha Adquisición de imágenes unilaterales de la mama derecha de la paciente 
Elementos utilizados: 5, 6, 7, 8 
SPEEDER no está disponible. 

 

4 BreastCX LatA 
bilateral 

Adquisición de imágenes bilaterales, elementos de bobina 
lateral no utilizados 
Elementos utilizados: 1, 2, 6, 5 
SPEEDER no está disponible. 

 

5 BreastCX MedA 
izquierda 

Adquisición de imágenes unilaterales de la mama izquierda, 
elementos de bobina medial no utilizados 
Elementos utilizados: 1, 3, 4 
SPEEDER no está disponible. 
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N.º Tipo de bobina Descripción 

6 BreastCX MedA 
derecha 

Adquisición de imágenes unilaterales de la mama derecha, 
elementos de bobina medial no utilizados 
Elementos utilizados: 5, 7, 8 
SPEEDER no está disponible. 

 

7 BreastCX DualA 
bilateral 

Adquisición de imágenes bilaterales, elementos de bobina 
lateral y medial no utilizados 
Elementos utilizados: 1, 5 
SPEEDER no está disponible. 

 

 

5.3 Posicionamiento y exploración de la paciente  

(1) Baje la camilla de la paciente hasta la posición más baja. 

(2) Extraiga todas las bobinas de RF que estén conectadas a los puertos de conexión del gantry 
y las bobinas de RF que no estén conectadas a los puertos de conexión de la superficie de 
la camilla. 

 
PRECAUCIÓN 

Asegúrese de que todas las demás bobinas se hayan retirado de la superficie 
de la camilla. Si se deja alguna bobina de RF desenchufada sobre la superficie 
de la camilla durante la exploración, se pueden producir quemaduras, 
imágenes anómalas o fallos de la bobina. 
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(3) Confirme la orientación de la bobina y colóquela sobre la superficie de la camilla.  

En los sistemas Vantage Titan y Vantage Orian, esta bobina se puede usar para 
exploraciones con la cabeza primero y con los pies primero (opcional).  

En los sistemas Vantage Elan, esta bobina se puede usar para exploraciones con 
la cabeza primero. 

Orientación de las bobinas 

 

Cabecera Pies 

 

 
En los sistemas Vantage Titan y Vantage Orian, se debe instalar el kit de modificación 
de la camilla, que es un accesorio opcional para el sistema de RM, para realizar 
exploraciones con los pies primero con esta bobina. Si se intenta realizar una 
exploración con los pies primero sin instalar el kit de modificación de la camilla, 
el centro de la bobina no podrá alcanzar el centro del campo magnético, lo que 
generará una calidad de imagen deficiente o imágenes anómalas. Si no está seguro 
de si el kit de modificación de la camilla está instalado, contacte con su representante 
de servicio de Canon Medical Systems. 

 

En los sistemas Vantage Titan y Vantage Orian, coloque primero el elevador de mama CX 
(opcional, se vende por separado) en la superficie de la camilla si es necesario debido al tamaño 
y el físico de la paciente o al tamaño del túnel del sistema. A continuación, coloque la bobina 
sobre el elevador de mama CX. 
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Bobina de mama SPEEDER CX con elevador de mama CX 

 

 

Maneje esta bobina con cuidado. Podría sufrir alguna lesión al transportar la 
bobina. Si la bobina se cae, usted podría sufrir alguna lesión o el equipo podría 
resultar dañado. 

 

(4) Conecte el cable de la bobina de mama al puerto de la superficie de la camilla. 

Puertos de conexión de bobina que se utilizarán para esta bobina 

En los sistemas Vantage Titan y Vantage Orian : Puerto A1 o A7 

En los sistemas Vantage Elan : Puerto A1 

 
PRECAUCIÓN 

Confirme que el conector de la bobina esté bien conectado y bloqueado en el 
puerto de conexión antes de iniciar la exploración. Si la exploración se realiza 
con el conector de la bobina no conectado al puerto de conexión, la bobina 
puede sufrir daños o se puede producir un calentamiento anormal. 
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(5) Superponga la correa móvil de inmovilización de la paciente como se muestra a 
continuación para fijar la bobina en la superficie de la camilla. 

Fije la bobina en la superficie de la camilla 

  

 
PRECAUCIÓN 

Confirme que la bobina esté sujeta a la superficie de la camilla antes de 
colocar a la paciente. Si la bobina no está fijada, podrían producirse lesiones. 
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(6) Coloque las almohadillas y los accesorios en el soporte de la paciente según sea necesario. 

Colocación de las almohadillas 

 

 
PRECAUCIÓN 

No permita que la superficie de la cinta gancho de las fijaciones de velcro 

entre en contacto con la paciente. Si la piel de la paciente roza con la 

superficie de la cinta gancho de estas fijaciones, podría sufrir lesiones.  

 

 
Si la paciente está delgada y/o experimenta dolor o molestias en las costillas, 
para reducir esas molestias puede colocar la almohadilla del sistema de 
RM debajo de la almohadilla de transición, como se muestra a continuación. 
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(7) Desbloquee las pestañas de bloqueo moviéndolas hacia abajo y luego desplace cada 
bobina lateral hasta su posición horizontal máxima. Bloquee las bobinas en su sitio 
moviendo las pestañas de bloqueo hacia arriba. Confirme que las bobinas no se puedan 
mover horizontalmente. 

Pestañas de bloqueo 

  

Desbloquee las pestañas de 
bloqueo 

Mueva cada bobina lateral a su posición 
horizontal máxima 

 
 

Bloquee las pestañas de bloqueo 
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Cuando mueva el soporte horizontalmente, no lo doble. El soporte podría 
sufrir daños. 

 

 

(8) Coloque a la paciente boca abajo sobre la bobina. Ajuste la posición de la región diana de 
acuerdo con el tamaño del seno. 

Si fuera necesario ajustar, retirar o reinstalar la bobina lateral o la placa de compresión, 
consulte la sección 5.1. 

(9) Ajuste la altura del reposacabezas usando el tornillo que hay en el lateral del reposacabezas.  

Reposacabezas y tornillo 

 

 
Asegúrese de apretar el tornillo del reposacabezas tras ajustar la altura. 

 

(10) Desbloquee las pestañas de bloqueo moviéndolas hacia abajo, luego desplace las bobinas 
laterales hacia la paciente hasta que estén en estrecho contacto con el seno. Bloquee las 
bobinas en su sitio moviendo las pestañas de bloqueo hacia arriba. Confirme que las 
bobinas no se puedan mover horizontalmente. 

(11) Confirme que no haya almohadillas, accesorios, bobinas laterales extraídas ni partes del 
cuerpo de la paciente que sobresalgan de la superficie de la camilla y luego levante la 
superficie de la camilla. 
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(12) Aplique la luz del proyector de posicionamiento sobre la región a explorar. Confirme de 
nuevo que la región que se va a explorar esté situada en el centro de la bobina lateral. 

(13) Pulse el botón «AUTO IN» (Inserción automática) para enviar a la paciente tendida en la 
camilla hasta el centro del imán. 

(14) Realice el registro de la paciente y seleccione las secuencias de adquisición de imágenes 
de la mama. 

 
Confirme que la dirección de inserción real de la paciente coincida con la 
configuración indicada en la pantalla del sistema de RM. Si la dirección de 
inserción se configura incorrectamente, los lados izquierdo y derecho de 
la paciente podrían mostrarse invertidos. 

 

(15) Seleccione los tipos de bobina para adquirir las imágenes requeridas, conforme a lo 
descrito en la sección 5.2. 

(16) Configure los estados como se muestra a continuación e inicie la exploración. 

Posición de la paciente: «Prono» 

Región SAR: «Mama» 

Para otras configuraciones y procedimientos de exploración, consulte el manual de 
instrucciones del sistema y el manual de adquisición de imágenes. 

(17) Cuando la exploración haya finalizado, pulse el botón «OUT» (Extracción) para que la 
superficie de la camilla salga del gantry. 

(18) Retire a la paciente de la camilla. 

 

 



 
 
 

44 | Página  6000919 Rev. 3 
 

Capítulo 6 – Limpieza, mantenimiento, servicio técnico 

y eliminación 
6.1 Limpieza de la bobina de RF 

 
PRECAUCIÓN 

1. No vierta solución de limpieza directamente sobre la bobina ni los 
accesorios. 

2. No esterilice la bobina ni los accesorios. 
3. No aplique solución de limpieza en los contactos eléctricos. 
4. No utilice bencina para limpiar el producto. Esto puede dar lugar a 

decoloración, distorsión, deterioro o daño. 

 

La bobina de RF y las correas se deben limpiar después de cada uso siguiendo el procedimiento 

que se indica a continuación: 

1. Desconecte la bobina de RF del escáner de RM antes de limpiar la bobina. 

2. Pase un paño seco por toda la superficie de la bobina para limpiar cualquier indicio de 

suciedad. Si hay suciedad difícil de eliminar, límpiela aplicando los procedimientos siguientes. 

3. Limpie con un paño o gasa humedecido con isopropanol al 70-99 %, etanol al 70 %, 

detergente suave diluido con agua o agua. 

4. Permita que la bobina se seque por completo, preferiblemente durante un día completo. 

5. Deseche todos los materiales utilizados para limpiar la bobina y las almohadillas de 

conformidad con lo dispuesto por las normativas de ámbito federal, estatal y local. 

6. También se pueden utilizar productos de limpieza comúnmente disponibles en la superficie 

de las bobinas sin que la seguridad del dispositivo se vea afectada. Consulte las instrucciones 

de uso del fabricante del producto de limpieza y limpie la bobina de acuerdo con los 

procedimientos especificados por el centro de atención médica. 

 
Algunos productos de limpieza pueden causar decoloración. Esto no afecta el correcto 
funcionamiento. 



 
 
 

45 | Página  6000919 Rev. 3 
 

6.2 Mantenimiento 

La bobina de RF no precisa de ninguna tarea periódica de mantenimiento. 

6.3 Reparaciones  

Póngase en contacto con el representante de Canon Medical Systems si tiene alguna pregunta 

sobre el servicio técnico de la bobina de RF. 

6.4 Eliminación 

Siga las normativas locales para la eliminación de equipos eléctricos. No deseche la bobina de 

RF en contenedores para residuos no clasificados. Póngase en contacto con el representante 

de Canon Medical Systems si tiene alguna pregunta sobre la devolución o la eliminación de la 

bobina de RF. 

6.5 Vida útil prevista 

Esta bobina de RF está diseñada para una vida útil prevista de al menos 6 años en condiciones 

normales de uso. Es seguro usar la bobina más allá de su vida útil prevista, siempre que se siga 

la información de la sección Seguridad y se superen las pruebas de control de calidad.  
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Capítulo 7 – Guía y declaración del fabricante – 

Compatibilidad electromagnética (CEM)  
Esta bobina requiere atención especial con respecto a CEM y debe instalarse y usarse de 

acuerdo con las pautas sobre CEM proporcionadas en este manual. Utilice únicamente la 

bobina de RF en el entorno especificado a continuación; la compatibilidad electromagnética no 

está garantizada en entornos distintos a los especificados. 

7.1 Clasificación 

Esta bobina de RF está clasificada como grupo 2, clase A por CISPR 11 cuando se utiliza en 

combinación con un sistema de RM. 

 
Las características de emisiones de este equipo lo hacen apto para su uso en 
áreas industriales y hospitales (clase A de CISPR 11). Si se utiliza en un entorno 
residencial (para el que normalmente se requiere la clase B de CISPR 11), 
es posible que este equipo no ofrezca la protección adecuada para los servicios 
de comunicación por radiofrecuencia. Es posible que el usuario deba tomar 
medidas para corregir esta situación, como reubicar o reorientar el equipo. 

 

7.2 Entorno y compatibilidad 

Esta bobina de RF está diseñada para su uso junto con un sistema de RM ubicado en una sala 

de exploración apantallada contra RF dentro de un centro de atención médica especializado. 

Todos los cables y accesorios forman parte de la bobina de RF y el usuario no puede retirarlos 

ni reemplazarlos.  

 
PRECAUCIÓN 

1. Si este equipo no se utiliza en el tipo de ubicación apantallada especificado, 
se podría producir una degradación del rendimiento del equipo, 
interferencias con otros equipos o interferencias con los servicios de radio. 

2. Debe evitarse el uso de este equipo junto con otro equipo o apilado con 
él, ya que esto podría dar lugar a un funcionamiento incorrecto. Si fuera 
necesario usarlo en este tipo de configuración, se deberá comprobar el 
correcto funcionamiento tanto de este equipo como del otro. 

3. El uso de accesorios y cables distintos a los especificados o presentados 
en este manual podría provocar un aumento de las emisiones 
electromagnéticas o una disminución de la inmunidad electromagnética 
de este equipo y provocar un funcionamiento inadecuado. 

4. Los equipos de comunicaciones de RF portátiles (incluidos los periféricos, 
como cables de antena y antenas externas) no se deben usar a menos de 
30 cm (12 in) de cualquier componente de la bobina de RF, incluidos los 
cables especificados por el fabricante. De lo contrario, podría producirse 
una degradación del rendimiento de este equipo. 
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7.3 Emisión electromagnética 

La bobina de RF solo puede funcionar cuando está conectada al sistema de RM, que se 

encuentra dentro de un entorno apantallado contra RF. Por lo tanto, no se aplica la cláusula 7 de 

IEC 60601-1-2 sobre emisión electromagnética. 

7.4 Inmunidad electromagnética 

Esta bobina de RF cumple con la cláusula 8 de IEC 60601-1-2 cuando se usa en el entorno 

electromagnético especificado. 

Prueba de inmunidad Prueba y nivel de cumplimiento 

Descarga electrostática (ESD), descarga de contacto 

 

IEC 61000-4-2 

8 kV  

Descarga electrostática (ESD), descarga de aire 

 

IEC 61000-4-2 

±2 kV, ±4 kV, ±8 kV, ±15 kV 
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Hasta el 30-07-2023: Zilverstraat 1, 2718 RP 
Zoetermeer, Países Bajos 
Después del 30-07-2023: Bovenkerkerweg 59, 
1185 XB Amstelveen, Países Bajos 

 

Persona responsable en Reino Unido: 
Emergo Consulting (UK) Limited 
c/o Cr360 - UL International 
Compass House, Vision Park Histon 
Cambridge, CB24-9BZ 
Reino Unido 

 

Distribuidores: 
Canon Medical Systems LTD. 
Boundary Court, Gatwick Road, Crawley,  
RH10 9AX 

Canon Medical Systems AG/SA Switzerland 
Richtistrasse 9, 8304 Wallisellen, Suiza 

Canon Medical Systems Europe B.V. 
Hasta el 30-06-2023: Zilverstraat 1, 2718 RP 
Zoetermeer, Países Bajos 
Después del 30-06-2023: Bovenkerkerweg 59, 
1185 XB Amstelveen, Países Bajos 

 
Representante autorizado en Suiza: 
MedEnvoy Switzerland 
Gotthardstrasse 28 
6302 Zug 
Suiza 

 

Fecha de la primera edición: 2023-02 / Fecha de revisión: 2025-02 

 


